
 

 
 
 

   NEW USERS TUTORIAL 2 
 

 
Preliminary: This tutorial is follow-on to the “New Users Tutorial.” Be sure to have first gone 
through that tutorial. Some features in this document will work only with certain ICAP/4 packages, 
though the vast majority works for ICAP/4Windows and higher offerings. 
 
 

Initial Procedure:  You’ve already learned many basic schematic operations from the initial New 
Users Tutorial.  Let’s examine some additional capability: 
 
1. Creating Schematic Layers and Configurations: Layering enables quick visibility and reuse 

of different design sections, while configurations save different versions of the design for test, 
production, documentation, etc. Invoke “File” and “New” menus to create a new drawing.  Pull 
up a few components and wire them together.  Invoke “Options” then “Layers” menus. Press 
“OK” inside the dialog box to save this portion of your design as the first layer.  Note the 
Configuration (design version) box says Config 1 atop of SpiceNet’s toolbar.  Next bring up the 
Layers dialog again and press “New,” then and click OK as Layer 2, then OK again. Pull up 
more components and add to your existing design. Wire the entire design together.  Next, from 
the “Options” menu, select the “Configurations” and “Edit” menus.  For drill, delete Layer 2 
from Config 1 by using the “Edit” box and clicking on Layer2 to delete it. Press OK.  Then use 
the “New” box to create a Config 2 and include Layer1 and Layer2. Click OK twice to close 
both dialogs.  Your first design version now contains only Layer1 of circuitry, and your second 
design version contains both layers.  You can select Config 1 or 2, then select the “eye” looking 
icon at the bottom left corner of the schematic page to highlight the different design layers for 
the configuration selected. This is a simple model, but in practice these designs could have been 
quite complex with Config1 as a commercial design version and Config2 as a sophisticated mil 
spec version. Note that if you close out the schematic and answer “Yes” to saving changes, then 
all the changes you made to the drawing, including any measurements you selected for 
recording (discussed later), simulation setup information, etc. will be saved. 
 

2. Schematic Parts Properties: Open the Sample2.DWG drawing from the “File” pulldown 
menu. Do this by browsing to the C:\spice8\Circuits\Sample2.  Double click on resistor R7 and 
select the “Tolerance/Sweep/ Optimize tab atop.  A name can be assigned within the “Sweep” 
column for the “Value” parameter, to be used as an inner or outer sweep loop for the part 
(discussed later).  Note that a different device tolerance can be easily assigned in the “Case 
Tolerance” column. Next select the “Failure” tab atop.  Then click on any fault condition that’s 
already present (if any) in the “Parameters” box’s “positive node” row (i.e., Open, Short, etc.).   
Go to the top “Parameters” row in gray. Single click on the “Open” entry (if present, else select 
any numbered entry atop and click twice). You’ll see all fault conditions you can change for the 
resistor. The netlist preview below will reflect those conditions as you select a fault condition. 
Further, individual values can be assigned to the “Value” field, “Temp” field, etc., which will 
be the values for these parameters only during a failure-mode simulation run. 
 

3. Recording/Displaying Electrical Measurements and Fault Simulation:  
You can setup and record (numerically) several types of electrical measurements for devices 
and nodes across a design. Select SpiceNet’s “ICAPS/Sim Ctl” icon from the top toolbar, then 
select the “Measurements” tab atop. Follow Closed Loop (design version), then down to tran 
(simulation setup), then click on TRAN (analysis selected in the simulation setup – there can 
potentially be more than one). If there’s an “InitialValue” entry below TRAN, click on it and 
press the “Delete” box to the right.  Let’s create some electrical measurements to be monitored 
and charted after simulation, including test limits and pass/fail indicators. Click on the “Add” box 
to the right. Press “Next” and “Next” again. Hold down the Ctrl key on the keyboard and select 
any number of design nodes and component parameters to be monitored during a simulation run. 



Once highlighted, pulldown the “RMS” measurement (or any choice) from the “Functions” box. 
Click the “Finish” box. In the “Measurements” tab you can now click the + box for RMS and see 
the design nodes and components you chose to be recorded during a simulation, or during a 
Monte Carlo statistical simulation, fault simulation, etc. Note that if you click any one of the 
individual entries, and the “Edit Tol” box to the right, you can change the individual min/max 
limits for pass/fail readout after the simulation. This is a significant capability for design 
compliance testing.  Select the “Main” tab atop. Select the “Standard” button in the “Mode” box 
toward the left.  Ensure the “Interactive” button and “Script” box are checked inside the “Data 
Reduction” box toward the right. Press the “Simulate Selections” box.  Finally, press the 
“Results” box. You now see the “measured” values for any design nodes and devices you selected 
for monitoring during simulation.  Note that the min/nom/max limits are not yet shown (unless 
you prescribed individual limits as previously mentioned).  So, select the “Set Limits” box toward 
the bottom of this dialog. Select “Expand to Pass,” then OK. Now values for the limits of ALL 
prescribed nodes and devices that you chose appear. You may have to set the “Precision” box 
below to 7 or 8 to see small differences in limits, and left-mouse hold and drag the small vertical 
lines between the min|nom|max in the grey row atop toward the right. 
 
For fault simulation with ICAP/4Professional and Test Designer, press the faults tab atop of the 
Simulation Control dialog.  You’ll notice R7 has a fault assigned, including any you may have 
added. A red X disables that fault from running and a green check enables it.  You can change 
these states by clicking on a fault and then clicking the “Switch Selected State” box atop in 
gray. Click a few such that only 4 faults have green check marks (Left hold the Ctrl or Shift 
keys to select multiple entries). To do a fault run, go to the “Main” tab atop, and select the 
“Closed Loop, Tran” simulation setup and design configuration entry. In the “Mode” box select 
the “Faults” button (lesser products can ascribe 1 fault at a time using the “Fault” box toward 
the right of the overall dialog. Next select the “Interactive” and “Script” selections in the “Data 
Reduction” box. Select the “Simulate Selections” box and answer “yes” to the “reference 
simulation” query.  When the fault runs complete press the “Results” box.  Note the measured 
values for the nodes and devices you originally set up for monitoring. These values are for a 
“no fault” conditions. By clicking on the + box on the left for the measurement you assigned 
(i.e., initial value, RMS, pk-pk, etc.) the individual nodes/devices measured results will then be 
displayed for the fault condition. For ICAP/4Professional and Test Designer products, click on 
the check box in the “Variation” box on the low-right corner of the dialog. The enabled faults 
you originally chose are atop of the list and are not preceded by a ~. Click on one of them. 
Notice how all the measured values and possibly the pass/fail bars change. Note that also with 
these two products that the individual design nodes and devices on the left need not be broken 
out if you want to see the fault condition results as a group).  For any Intusoft fault-capable 
product, you can try to “Expand to Pass” the test limits by selecting the “Set Limits” box 
below.  You can select the “Default” or “Set Value” boxes and assign corresponding limits this 
way. Had you previously run a Monte Carlo run (covered later), you could select the “Sigma 
Limits” box and expand the test limits by whatever sigma amount (sigma is in relation to the 
tolerance of a device, i.e., 3 sigma would be 5% variation on a resistor of a 5% tolerance). 
When done, select another fault and see how the design nodes’ and devices’ measured values 
change, and if they pass or fail with the newly expanded test limits.  
 

4. Running a Nested Sweep: Interrelated sweeping of two components can be performed. This 
enables a device to be incrementally stepped through a range of values or parametric variations, 
upon the completion of a second device fully stepped through its range. While in the Simulation 
Control dialog box press the “Sweep” box below.  Under “Ref Des: select R7. Select “Edit 
Part.”  In the “Value” row and under the “Sweep” column type in any name, i.e., “Rvary.” 
Press OK and note the newly added information in the original “Sweep” dialog box.  Repeat the 
process for C1, but assign the name “Cvary.”  Next under “Outer,” pull down “Rvary.” Assign 
the Start, Stop and Step values of 1k, 100k and 20k.  Under “Inner” pull down “Cvary” and 
enter .1u, 1u, and .3u for the step size. Click on OK.  Scroll down to the “SWEEP” selection in 



the “Mode” box. Ensure the “Interactive” button is checked in the “Data Reduction” box.  Press 
the “Simulate Selections” box. When the sweep simulations are done, press the “OK” box. 
 
Click on the “Scope” icon in the schematic’s upper toolbar. Select the “Window” menu 
pulldown, then “Add Waveform” in the dialog. Click on the “Sweep” box below. Select “V(1)” 
in the “Vector Argument” box then “average” in the Function box.  Click on the “Add Function 
to Plot” box, then the “Plot All Cases” box to display a curve family for the V(1) node’s 
waveforms.  Note you can change the X axis units by pulling down any selection from the “X 
axis” box, then select the “Add” box. 
 

5. Further Use of  IntuScope: Let’s begin by creating a clearer view of the 20 waveforms in view.  
Expand IntuScope to full-screen.  Select the “Unlink All Y” icon atop (circle with red diagonal 
line). Now you can see variations in the waveforms. The “Link All Y” and “Tile All Y” icons also 
serve to help display waveforms in helpful ways; try them. Try the “Zoom” icon atop and left-
hold the mouse to drag it around any area of the waveform plot.  To resume to the original 
waveform display you can press <Ctrl Z> any number of times. Right click to deselect zoom. 
Now, select the “Scaling” menu pulldown atop and the “Scaling Dialog” menu. Here you can left-
mouse drag the perimeter box around the thumbnail waveform and click the “Apply” box to 
zoom around waveforms. Click on the “Auto Scale” box to restore the original view. 
 
Next select the “Options” menu pulldown atop, then “Font” and “Legend Font.”  Select 11 for 
the font size, then optionally click on the “Always use this font size” button. Notice the 
increased font size in IntuScope. The original “Automatically reduce font size” option can be 
restored if desired. Press the <Ctrl T> keys and notice the waveforms are displayed from top to 
bottom, listing the last waveform selected on top. If you select any waveform atop of the 
window, its waveform number will be highlighted on the right of the graph, and its 
corresponding Y-axis data will butt against the Y axis.  
 
Now go to the “Calculator” menu pulldown and select “Labels” (choose any). Try the 
Calculator’s “iDrawing” and “Dots” menu selections.  Note the changes on the plot. 
 
An unlimited amount of waveform cursors are available. These show numerical data about the 
X & Y axes for waveforms, including delta between signal levels. Continue clicking on the 
cursor’s Y<1 or 1>Y boxes below to identify numerical readouts for individual simulation 
points along the dotted waveform. Next select the cursor “Select” box to add a cursor. Click the 
“Add Cursor” box and click one of any of the cursor selections on each side (i.e., 0, 1, 2…) and 
“OK.” The respective cursors will come to view in IntuScope. 
 
Another useful technique for isolating 1 or 2 waveforms embedded within several others is to 
select a desired waveform’s name atop and press the <Ctrl C> keys.  Select “File” and “New 
Graph” menus. Click on the new graph and press the <Ctrl V> keys to paste the waveform. Select 
the “Window” and “Tile Vertically (or Horizontally)” menus to see both plots. 
 
Press the <f> key and an FFT will be performed on the active signal in IntuScope. Select the 
Calculator’s “iDrawing” and “loglog” menus and notice the change in the FFT display. Select the 
“Actions,” “Text Edit” and “Output” or “Input” menus to view the SPICE netlist and output files. 
 

6. Schematic-less Parametric Sweeping: Bring up the IsSpice4 windows (accessed from the 
desktop’s bottom toolbar).  In addition to expediting real-time waveform displays as 
simulations run, you can also change device values and their parametric data and watch 
resulting waveforms progress, all without changing the schematic.  Select the “Stimulus” box 
from the “Simulation Control” window. Click the “Stimulus” box and scroll down to “R4” in 
the “Stimulus Picker” dialog box.  Select “resistance-Resistance” and “OK.”  Next select the 
“Measure” box from the “Simulation Control” window. Click on “Main Nodes” and V(1).  
Press “Select” and “Make.”  Close out the “Stimulus Picker” box and drag the small “Stimulus” 
and “Measurements” windows to desired locations. Check the “Always” box inside the 



“r4:resistance” dialog box. Note the “Plots” box back in the “Simulation Control” window. Pull 
down the “ref” entry (standard simulation run), since the previous runs were from the sweep 
you did.  Press the <Ctrl T> keys to re-scale the thumbnail waveforms.  Now you’re set to do 
some real-time sweeping on R4.  In the “r4 resistance” dialog box, press the “Set” box.  Notice 
the “Measurements” dialog box value of V(1)  comes to view.  Next press the largest right-hand 
arrow in the “r4 resistance dialog box. The real-time waveforms update. Press the “refresh” box 
in the “Measurements” dialog to update V(1)’s numerical value. 
 

7. Monte Carlo Analysis:  Bring to view the “Simulation Control” dialog box by clicking its icon 
from the schematic’s top toolbar. Next click on the “Monte” box toward the bottom. Fill in 1 
and 10 in the Lots and Cases boxes (1 lot of 10 statistical runs) and click “OK.”  Click on the 
“MONTE” selection in Simulation Control’s “Mode” box. Ensure the “Interactive” button and 
“Script” box are checked inside the “Data Reduction” box.  Click the “Simulate Selections” 
box. Click on the “Scope” icon in the schematic’s top toolbar. Select the “Window” menu 
pulldown and “Add Waveform.” Select the “Monte” box toward the bottom of the dialog box. 
Select “V(18),” “average” and the “Add function to plot” box. Select the “Plot All Cases” box 
to view the curve family.  Click on the “Histogram” and “Probability” boxes next.  The 
histogram illustrates how many runs (labeled sigma intervals) fell within a range of voltages 
(bins).  The Cumulative density plot shows the voltage levels for each run (dots) on the Y axis, 
and the X axis shows each run’s value for V(18), represented symmetrically about the axis’s 
“0” midpoint (probability) for all of the runs.  
 
View any of the advanced multi-run scripts back in the “Simulation Control” dialog box by 
selecting the black question mark (context-sensitive help), then click on a desired script name 
(i.e., MONTE) to learn more about it. This can also be done for any function in SpiceNet and 
IntuScope. It’s easy to select say EVA, WCA, SEN and run a simulation. Results for EVA and 
WCA are found by selecting the “Results” box and viewed as measurements for design nodes 
or devices you’ve set up for monitoring. SEN results are found in IsSpice4’s Output file. 
 

8. Adding a New Model From the Web to Library: To add a new SPICE model to the ICAP/4 
library, begin by highlighting a SPICE model netlist from the internet and copying to clipboard 
(i.e., http://www.national.com/models/spice/LF/LF156.MOD). Then, select SpiceNet’s “File” and 
“Import Spice Model” menus, and select “From Clipboard.”  This example is for an LF156/NS 
JFET input op-amp from National Semiconductor. ICAP/4’s Library Manager automatically 
imports the netlist, checks to see if the part is already in the parts database, and assigns the new 
model to the parts library.  Select that the part be stored in the “From_Import.lib.” The schematic 
entry system will automatically find it there. Agree to update the parts database if queried.  This 
takes a couple of minutes for compilation. Next, go back to SpiceNet and invoke the parts browser 
(x key). Under the “From_Import.lib” lies the new LF156 model.  It contains a default symbol for 
the part. Assigning a conventional op-amp symbol is the next step.  Go to the “Opamps” Part Type 
box, select LT-“LFxxx” in the “Sub Types” box and a symbol will appear for that part.  At the 
bottom of the “Part Browser” dialog box is the pathname to that symbol (SymLib: 
C:\spice8\\SN\SYMBOLS\LIN-IC.sym\LTOPAMP): Highlight the very end of that string 
(LTOPAMP) by holding the left mouse button down and dragging it, then copy those letters to 
clipboard.  Next, go to: C:\spice8\PR\mylib and open the “From_Import.lib” file.  There you’ll see 
the netlist for the LF156/NS part.  The *SYM line toward the top should be changed from “05pin” 
to “LTOPAMP” (paste from clipboard now). Close the file and save it when queried.  Update the 
parts database from SpiceNet’s “File” menu, choosing the “Update Part Database” menu.  Once 
done you can invoke the Part Browser again and find/place the new part and its new symbol.  

 
9. Creating a Subdrawing or Subcircuit Using Help: Invoke the yellow question mark icon in 

SpiceNet’s upper toolbar to invoke SpiceNet help.  Within the “Search” tab, type in subdrawing 
(or subcircuit). Select “Subdrawing” (or Subcircuit) in the “Select Matching Words” box.  
Select  “Make a Subdrawing” (or subcircuit) in the “Choose Topic to Display” box.  Follow 
instructions on the right side of the help window. 
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